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Introduction

AutoPilot® for Windows 2.0 gives you the power to monitor and control your entire operation from your PC.
The user-friendly meter view and simplified navigation make AutoPilot easy to leam and use. With AutoPilot
Scripts, you have the power and flexibility you need to for advanced automation. Whether you have one site or
dozens, AutoPilot for Windows 2.0 gives you the control you need.

This Quick Start Guide will lead you through the process of configuring and connecting to your sites using the
ARC-16 Wizard.

For additional help, please consult the help file by clicking on Help in the menu bar.

Installing AutoPilot for Windows 2.0

To install AutoPilot, put the CD in your drive. The CD Browser should open automatically. If it does not,
double click on the icon for your CD-ROM from My Computer, and then run “Launch”.

i
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Note: If you are using Windows NT or 2000, you must have administrative privileges to install AutoPilot.

Click Install to run the installer. When prompted for your Program Key, enter the key supplied by Burk. If you
do not have a Program Key, leave the field blank to run AutoPilot in demo mode.

Starting AutoPilot

To run AutoPilot, open the Start Menu, and go to “Burk Technology\AutoPilot for Windows 2” and click
“AutoPilot for Windows”.
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Logging In

When AutoPilot is first installed, it includes one user,
“Administrator”, with a blank password. When you first start
AutoPilot, log in by selecting “Administrator” from the User list
and clicking Login. You can change the password and add more
users later (consult the help file for more information).

f“ Always log in as this user automatically

Using the ARC-16 Wizard

BNewARC-16..'l—»ar:____________
'Connect

Connect Using...

The ARC-16 Wizard is used to add ARC-16s to AutoPilot, and can also be used to
modify your settings later. To launch the wizard, click “New ARC-16” from the File
menu. After each step, press “Next” to continue.

1. ARC-16 Properties: Enter a name for this ARC-16, the serial number, user password from the ARC-16,
and your authorization code. If you do not yet have an authorization code, please contact B urk
Technology. If you are running AutoPilot in demo mode, leave the authorization code field blank.

j?JxJARC-16 Wizard>

ARC-16 Properties
Choose a name for your ARC-16 and enter the serial number and password. These
values can be found in the unit's setup menu.

< Back i Next > Cancel



2. ARC-16 Group: Every ARC-16 must be part of a group, even if you have a Stand Alone. A group can
have up to four ARCs, all connected to each other. To add a new group, select “Add new group..from
the drop down list, and enter a name for the group. Next, select the site letter of your ARC.

3. Time Zone: Select the time zone in which your ARC-16 is located. You can also enter abbreviations for
Standard Time and Daylight Saving Time. These abbreviations will appear when you print reports. If the
time zone you are using does not use Daylight Saving Time, be sure to uncheck the box for that option.

4. Logging: To enable logging on this ARC, check the “Enable Logging” checkbox. Choose either hours or
minutes and enter the logging interval. To log starting at a specific time, enter that time for “Next Log”.
For example, if you want to log every hour on the hour: choose “Hours”, enter 1 for the interval, and set
the Next Log time for the next hour.

5. Adding a Connection: To add a new connection, choose
“Yes” and press next. You can add either a Direct connection
(using a serial port), or Modem. Enter a name for the
connection, and choose the COM Port or Modem that you want
to use. If using a modem, you must enter the phone number as
well. You can also make this the default connection for the
group, which lets AutoPilot connect without prompting you to
choose a connection. The default connection can be used to
connect to the group automatically at startup if “Connect
automatically at startup” is checked.

-Connection Type---------------------------------

C Direct (• Modem

Name: | My Connection

J7 Make this the default connection for the group

0 Connect automatically on startup

Modem:
13Com Windows Modem PCI ADI

Phone Number:
1555-1234

6. Add Channels: Check the box in the “add” column for each channel that you want to add. You can also
change the channel name and units for analog readings. Note: use the sample channel on the left to see
what the channel will look like in AutoPilot.

ARE-16 Wizard* ?12<1

Channels
Select the channels that you want to use. You can specify a label for each channel,
and the units that the readings are measured in. '

Number Add Channel Label Units |
1 0 Filaments Volts
2 0 Channel 2
3 □ Channel 3
4 □ Channel 4
5 □ Channel 5
6 □ Channel 6
7 □ Channel 7
8 □ Channel 8
9 □ Channel 9
10 □ Channel 10
11 □ Channel 11
12 □ Channel 12
13 □ Channel 13 ________  T

< Back Next > Cancel |

7. Channel Properties: For each channel that you want to customize, first select the channel from the drop
down list. You can change the raise and lower labels, status on and off labels, command durations, and
status indicator colors. Check “Log status changes” to have AutoPilot log each time the status of the



channel changes.
8. Meter Properties: The appearance of the meter is customizable for each channel. You can change the

min and max values, colors, and values where the color changes. Note: you do not have to use all five
colors, to use only two colors, for example, set the “Ends at” value for Meter Colors 3-5 to equal the
Minimum Value. (

9. Press finish to add the ARC-16 to AutoPilot. '

Connecting to your ARC-16

[Tile Edit View Tools Help

New ARC-16... g.

Connect Using...

To connect to your ARC, click Connect from the Fi le menu. If you set your
connection as the default, AutoPilot will connect immediately, otherwise you will be
prompted to choose from a list of connections.

Additional Help

For more detailed instructions and information on AutoPilot’s
many other features, please consult the help file, accessible from
the Help menu in AutoPilot. Additional information can also be
found on the Burk website: www.burk.com.

For technical support, email support@burk.com, or call (978)
486-0086.

O WXYZFM

Channel 1 C About AutoPilot...

Index.,.

Search...
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What’s New
AutoPilot for Windows 2.0 is a completely new version, built from the ground up to improve reliability and
ease of use. If you've used a previous version of AutoPilot, you will immediately notice many of the changes.
Getting up and running on 2.0 won't take long at all, though, as AutoPilot's new wizards make setup a breeze.
Here are some of the changes and new features:

• New meter view and easier navigation: AutoPilot now provides a page of meters for each site. The
values displayed on the meters can be customized, as well as the colors. To switch between sites, just
click on the desired site from the tab list below the toolbar.

• ARC-16 Wizard: The ARCGCLWizard takes you through adding a new site step-by-step. You can add a
connection, configure logging, and customize your meters all in the same process. Once the wizard is
complete, you're ready to connect to your ARC.

• Scripting: Version 2.0 replaces "Functions" with Scripts, based on the Visual BASIC Script (VBS)
language. Scripting gives you a great deal of power, allowing you to handle any situation. If you're not
familiar with VBS, no problem. The Script Wizard will generate commonly used scripts painlessly - you
don't have to write a single line of code! And the Script Editor provides an easy to use code writer so you
don't have to memorize script commands or syntax. See AutoPilot Lx_Funclions for more information.

• Better Reports: AutoPilot now gives you more control over the look and content of your reports, using
the Report Wri ter. You can select exactly what kind of data you want to see, and even add custom
headers and footers. Once you've configured your report, you can save the template so you don't have to
go through the setup next time. You can also export your data so you can view it with ahnost any other
application.

Read the Quick Stall Guide to get up and running, and be sure to review the rest of the help file for information
on scripting, printing reports, and the other new features in AutoPilot for Windows 2.0

AutoPilot® 2.0
©2001 Burk Technology, Inc.
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Introduction

System Requirements

Getting Started

How to Get Help

The help file can be accessed from AutoPilot by clicking on the help menu.

_?J" What's This" help is also available to provide quick descriptions of AutoPilot's features.

If you require further assistance, please contact Burk Technology.

To get started, read the Quick Start Guide. This will explain how to configure and connect to your ARC-16(s)
quickly and easily. If upgrading from a previous version, read about What's New. The help file also provides
instruction for:

AutoPilot® 2.0 gives you the power to monitor and control your entire operation from your PC. The user-
friendly meter view and simplified navigation make AutoPilot easy to learn and use. With AutoPilot Scripts,
you have the power and flexibility you need to for advanced automation. Whether you have one site or dozens,
AutoPilot 2.0 gives you the control you need.

Pentium II or equivalent
64MB RAM
Windows XP, 2000 Pro SP1, NT 4.0 SP5
Microsoft Internet Explorer 4.01 SP2 or newer
Bell 212A compatible modem (if using a modem connection)

A uto Pi 1 ot Con figur ati on
Basic Operation
Writing Scripts
Viewing Reports

AutoPilot® 2.0
©2001 Burk Technology, Inc.
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AutoPilot Configuration
To learn more about configuring AutoPilot, choose from the topics below:

• Adding ARCs with the ARC-16 Wizard
• Managing connections
• M_anaging.groups
• Managing users

AutoPilot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
support@burkxom



Managing Groups
An ARC-16 "group" can comprise up to four units. Every ARC-16 in AutoPilot is part of a group, even if you
are only using one ARC. When you connect to any ARC in a group, AutoPilot is able to communicate with all
of the units in that group.

To add, delete, or edit groups, click "Groups..." from the Edit menu.

ARC-16 Group

Name:
|My Group

-ARC-16s in this Group

W FM
\VXrZ AM

P This is the default connection for the group

p Connect to this group automatically at startup

- Connections to this group

Adding Groups

Click New to create a new group. Enter a name for the group, and press Save. Because this a new group, there
will not be any ARC-16s in the group, nor will there be any connections to it.

Modifying Groups

Select the group from the Groups list. You can change the name, and set one of the .connections to the group as
the default. If you make a mistake, you can click Undo to revert back to the original settings.

Deleting Groups

Select the group that you want to delete from the Groups list. Click the Delete button on the dialog to delete it.
Warning: when you delete a group, all of the ARC-16s and connections for that group will be deleted as well.



Group Settings / 1

Groups list
The Groups list displays all of the groups that you have added to AutoPilot. Clicking on a group in the list will
display its properties in the fields below.

Group Name
The group name is used to refer to this group in AutoPilot.

ARC-16s in this Group
The ARC-16 list shows all of the ARCs, if any, that are part of this group.

Connections to this group
The connections drop down list displays all of the connections to this group (connections can be defined to any
of the ARC-16s in the group). Select a connection if you want to change its default status.

Default Connection
If a connection is the default for the group, AutoPilot will use that connection when connecting without first
prompting you to choose from a list.

Connect to this group automatically at startup
If the connection is the default for the group, AutoPilot can use it to connect when the program starts up.

AutoPilot® 2.0
©2001 Burk Technology, Inc.
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Managing Users
AutoPilot user account are used to restrict access to AutoPilot and some of its features to only the people whom
you choose. An Administrator account is built in. This account can not be deleted, but can be renamed. Note
that the default password is blank; to change this password, see below.

To access the Edit Users dialog, click "Users..." from the Edit menu.

Users
(Administrator
New User • |

User Name
(New User

Password

I--------------
Confirm Password

- Privileges---------------------------

P Administrator

r Manage ARC-16s

P Connect/Disconnect

P Issue Commands

P Clear Alarms

P Enable/Disable Scripts

P Run/Schedule Scripts

P Write Scripts

P Enable/Disable Logging

P View Logs and Reports

P Edit Calendars

Add a new user

Press New to create a new user. You can change the User Name and set a password, as well as assign privileges
(see below). Press Save to save your changes.

Modify a user

Select the user that you want to edit from the Users list. You can change the name, password, and privileges
(see below). Press Save to save your changes, or press Undo to revert back to the original settings.

Delete a user

To delete a user, press the Delete button on the Edit Users dialog. Note: you can not delete the built-in
Administrator account.

User settings

Users list
To edit or delete a user, click on the desired user name from the Users list.

User Name
The user name can be up to 25 characters long.



Password
The password can be up to 16 characters long, but can be left blank if desired. You must retype the password in
the Confirm Password field.

Privileges

Privilege Description

Administrator Grants the user all other privileges, as well as the ability to manage other users. The
administrator can also modify purge_settings.

Manage ARC- 16s Allows the user to add, delete, and edit ARC-16s, connections, and groups.
Connect/Disconnect The user can connect and disconnect ARC-16s.
Issue Commands Gives the user the ability to issue raise and lower commands.
Clear Alarms Allows access to the Clear Alarms button.
Enable/Disable Scripts The user will be able to enable and disable scripting.
Run/Schedule Scripts Allows the user to run scripts, or change the schedule settings of a script.
Write Scripts Gives the user access to the Script Editor and Script Wizard.
Enable/Disable
Logging The user can enable and disable logging in AutoPilot.

View Logs and Reports Allows access to the Report writer and export features.
Edit Calendars Grants the user access to the Edit Calendars dialog.

AutoPilot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
syppQrt.@byrkxprn



Managing Connections
You can add a new connection when you first setup your ARC using the ARC_-_1.6_Wjzard. To add a connection
afterwards, or to modify an existing connection, click "Connections..." from the Edit menu.

Choose a connection:

' Connections

Name ARC-16 Group J ...................... 1
Test WXYZFM My Group ----------- —----------

Save

Undo

Delete

Close

ARC-16:
|WXTZFM 3

Connection Name:
|New Connection

I- Default Connection for the group

F Connect automatically on startup

Type: (• Direct C Modem

COM Port:_________________________
jcOM1 3

Adding a new connection

Press "New" to add a connection. You must also select which ARC-16 you will be connecting to directly, using
the "ARC-16" drop down list. Press save when you have finished setting up your connection.

Modifying a connection

Click on a connection in the "Choose a connection" list. When you have finished changing your settings, press
Save. If you want to revert to your original settings, press Undo.

Deleting a connection

To delete a connection, select it from the "Choose a connection" list, and click the Delete button on the
Connections dialog. If you delete your only connection to a group, you will no longer be able to connect to that
group.

Connection Settings

Connection Name
Enter a name for the connection. The connection name will identify this connection in AutoPilot and scripts.

Default Connection for the group



Check this box to make this the default connection for the group. When connecting to any ARC in the group,
AutoPilot will use this connection without asking you to first choose from a list. Note: you can still choose
which connection to use by clicking "Connect Using..." from the File menu.

Connect automatically on startup
If you made this the default connection, you can check this option to allow AutoPilot to connect to this group
when the program is started.

Connection Type
Choose either a direct connection (using your computer's serial port and a null modem cable), or a modem
connection, using your modem to dial into the ARC-16.

COM Port
If using a direct connection, choose the COM Port that you want to use from the list. Note: if you do not see
your COM Port in the list, it is not installed correctly in Windows.

Modem
If using a modem connection, choose the modem that you want to use from the list [not shown]. Note: if you do
not see your modem in the list, it is not installed correctly in Windows.

Phone Number
If using a modem connection, you must also enter the phone number that you want AutoPilot to dial [not
shown].

AutoPilot® 2.0
©2001 Burk Technology, Inc.
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ARC-16 Setup
The ARC-16 Wizard takes you step-by-step through the process of adding ARC-16s to AutoPilot. This section
of the help file will guide you through each page of the wizard. To skip directly to a specific topic, choose from
the links below:

• ARC-16 Properties
• ARC-16 Group
• Time_Zpne
• LoggingOptipns
• AddJMew_Connection
• Connection Details
• Add Channels
• Channel Properties
• Meter Properties

To start the wizard, click "New ARC-16" from the File menu.

AR0||_________________

'Connect

Connect Using...

To change your ARC-16 settings, you can return to the ARC-16 Wizard by clicking "ARC-16 Properties..."
from the Edit menu. To delete an ARC, click "Delete ARC-16..." from the Edit menu. Note: you can only add a
new connection using the wizard when you first setup the ARC. To add connections later, see Managing
Conne_ctions.

ARC-16 Properties

AutoPilot® 2.0
©2001 Burk Technology, Inc.
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ARC-16 Properties
ARE-l&Wizard)

ARC-16 Properties
Choose a name for your ARC-16 and enter the serial number and password. These
values can be found in the unit's setup menu.

ARC-16 Name:

Serial Number: £

Password: [

Confirm Password:

Authorization Code:

< Back i Next > i Cancel

Site Name
Enter a name for your ARC-16. This name will be used to select your ARC in AutoPilot, as well as in scripts.

Serial Number
Enter your ARC'S serial number. The serial number is printed on the back of the ARC-16, and appears at the
end of the configuration menu on the front panel of the unit.

? iPassword ■ ’
Enter the User Password for your ARC. This appears in the system configuration menu on the ARC. Re-enter
the password in the "Confirm Password" field.

Authorization Code
Enter the authorization code given to you by Burk. Each ARC-16 requires its own authorization code. If you do
not have one, please contact Burk. If you are running in demo mode, just leave this field blank.

Press "Next" to continue.

ARC-16 Group
* ARC-16 Setup

AutoPilot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
support@burk.com



ARC-16 Group
ARC-16 Wizard

ARC-16 Group
Add your ARC-16 to a group Each group can have up to four units (A D). The Site
Letter can be found in the ARC-1 B's setup menu.

Choose a group:
| Add new group...

Name: Group

§ r b r c r d

Jjxj

< Back. Next > Cancel

ARC-16 Groups
Every ARC-16 must be part of a group, even a Stand Alone. A group can include up to four units, all connected
to each other. When AutoPilot connects to one ARC in the group, it can talk to every other ARC in the group as
well.

If you have already added a group to AutoPilot that will include the new ARC that you are adding, just pick that
group from the "Choose a Group" drop down list.

If you want to add a new group, choose "Add new group..." from the list. Enter a name for the group in the
"name" field.

Site Letter
Select the site letter for your ARC-16. Note: each letter can only be used once for each group. The site letter is
determined when you first configure your ARC.

Press "Next" to continue.

Time Zone
ARC-16 Properties

AutoPilot® 2.0
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Time Zone
ARC-16Wizard<

Time Zone
Select the time zone for your ARC-16. When logging, AutoPilot will compensate for the
time zone and Daylight Savings Time automatically.

Jjxl

| GMT Bias
Choose a time zone:

GMT:05:00’
GMT-05:00
GMT-05:00
GMT-06-00
GMT-0&00
GMT-06:00

Time Zone 1 Locations
|iE'yrerHliy^^*fe|Wstejh^Tiffiei(IJS^Canada)
SA Pacific Bogota, Lima, Quito
US Eastern Indiana (East]
Canada Central
Central
Mexico

Saskatchewan
Central Time (US & Canada)
Mexico City

Standard time abbreviation: JesT

Daylight time abbreviation: |edT

17 This location uses Daylight Saving Time

< Back I Next > Cancel

Choose a time zone
When AutoPilot takes a log or runs a script, it is sensitive to which time zone your ARC-16 is in. Choose the
appropriate time zone from the list. You can also enter abbreviations for Standard Time and Daylight Time.
These abbreviations will appear in your logs. If your time zone does not use Daylight Saving Time (DST),
remember to uncheck the DST option. Note: if you are not using DST, AutoPilot will ignore the Daylight Time
abbreviation field.

Press "Next" to continue.

Logging Options
* ARC-16 Group

AutoPilot® 2.0
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Logging Options

Enable Logging
Check "Enable Logging" if you want AutoPilot to log readings from this ARC-16.

Interval
Enter the number of hours or minutes after which AutoPilot should record a log. Select "Hours" or "Minutes"
using the options below the interval field.

Next Log
Enter the time when AutoPilot should take its first log for this ARC. This will set a pattern for all future
logging. For example, to log every hour on the hour, enter 1 for the interval and select "Hours", and enter the
next hour for Next Log. If the next hour is 6:00, AutoPilot will log at 6:00, 7:00, 8:00, etc. If you set the interval
for 15 minutes, AutoPilot will log at 6:00, 6:15, 6:30, etc.

Press "Next" to continue.

* Add. New_Connectipn
Time Zone

AutoPilot® 2.0
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Add New Connection
ARC-16 Wizard'

Add new connection
Add a connection for this ARC-16 if you will be connecting directly to it You do not
need a connection if you are already connecting to another ARC-16 in this group.

< Back Next > Cancel

Select "Yes" to add a new connection for this ARC-16.

If you already have a connection for an ARC in this group, you do not need to add another one. Select "No" to
skip to the connection settings.

Press "Next" to continue.

Connect ion Details
Add Channels
TimeZone

AutoPilot® 2.0
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Connection Details
ARC-16 Wizard1 JL12SJ

Connection Details
Choose either a direct (serial) or modem connection, and give your connection a
name. Press the test button to make sure your connection works.

-Connection Type---------------------------------

C Direct (• Modem

Name: [j

Make this the default connection for the group

r Connect automatically on startup

Modem:

I 3
Phone Number:

< Back Next > Cancel

Connection Type
Choose either a direct connection (using your computer's serial port and a null modem cable), or a modem
connection, using your modem to dial into the ARC-16.

Connection Name
Enter a name for the connection. The connection name will identify this connection in AutoPilot and scripts.

Default Connection
Check this box to make this the default connection for the group. When connecting to any ARC in the group,
AutoPilot will use this connection without asking you to first choose from a list. Note: you can still choose
which connection to use by clicking "Connect Using..." from the File menu.

Connect Automatically
If you made this the default connection, you can check this option to allow AutoPilot to connect to this group
when the program is started.

COM Port
If using a direct connection, choose the COM Port that you want to use from the list [not shown]. Note: if you
do not see your COM Port in the list, it is not installed correctly in Windows.

Modem
If using a modem connection, choose the modem that you want to use from the list. Note: if you do not see your
modem in the list, it is not installed correctly in Windows.

Phone Number
If using a modem connection, you must also enter the phone number that you want AutoPilot to dial.



Press "Next" to continue.

AddChannels
Add New Connection

AutoPilot® 2.0
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Add Channels

Cancel j

ARC-16 Wizard!

Channels
Select the channels that you want to use. You can specify a label for each channel,
and the units that the readings are measured in.

< Back | Next > |

Number Add Channel Label Units | -*•
1 0 Filaments Volts|
2 0 Channel 2
3 □ Channel 3
4 □ Channel 4
5 □ Channel 5
6 □ Channel 6
7 □ Channel 7
8 □ Channel 8
8 □ Channel 8
10 □ Channel 10
11 □ Channel 11
12 □ Channel 12
13 □ Channel 13 ___________________▼'

Add Channels
Click the checkbox in the "Add" column for each channel that you want to add to this ARC-16. Note: adding a
channel adds analog readings, control, and status.

Channel Label
Enter a label to describe the analog readings. Note: control and status labels will be entered later.

Units
Enter the units in which your analog readings are measured.

Sample Meter
The sample meter will show you what your channel will look like in AutoPilot. You can use this to make sure
your labels will fit in the space allowed. Note: Pressing the Raise and Lower buttons on the sample meter will
move the needle from minimum to maximum.

Press "Next" to continue.

Channel Properties
Connection Details
Add New Connection

AutoPilot® 2.0
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Channel Properties
ARC-16 Wizards

Channel Properties
Set labels for Raise, Lower, and Status. To change the status color, click on the color
swatch.

-Sample

0 Volts

C' On

A Raise

Y Lower

Select a channel:

n-------

| LowerLower Label:

Status On Label: j(jn

Status Off Label: joff

17 Log status changes

Duration: | I.Q-^—j

Duration: | 1 g-y-j

Color: [_ j

Color:

< Back Cancel

Select a Channel
To edit a channel, choose the channel you want from the drop down list.

Raise and Lower Labels
You can change the labels for Raise and Lower. These labels will appear in AutoPilot, and will be used when
logging commands.

Raise and Lower Duration
Enter the duration of the command. The duration can be from 0.5 to 28 seconds.

Status On/Off Labels
Enter labels for status on and off. These labels will appear next to the status LED in AutoPilot, and in your logs.

Status On/Off Colors
You can also change the color of the status LED for on and off. Click on the color swatch to pick the color you
want.

Log Status Changes
Check this box to have AutoPilot log each time the status of this channel changes.

Press "Next" to continue.

Meter Properties
Add Channels

AutoPilot® 2.0
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Meter Propertoes
ARC-16 Wizard)

Meter Properties
Specify the minimum and maximum values for the meter. To customize the colors, clici "Trff*
□n the color swatch. '

-Sample

0 Volts

C On

A Raise

Lower

Select a channel’

Meter Color 1:

Meter Color 2:

Meter Color 3:

Meter Color 4:

Meter Color 5:

Ends at: 10000

Ends at: | eOOO^Tj

Ends at. ] GOOO^J

Ends at: | 4000^

Ends at: | 2000^j

Minimum Value:

Maximum Value: 10000±j

< Back Next > Cancel

Select a Channel
Select the channel that you want to edit from the drop down list.

Meter Colors
Click on a color swatch to change the color. The meter colors are numbered top to bottom. You can use up to
five colors, but to use fewer, set the "Ends at" value to be greater than or equal to the maximum value. For
example, if you want your meter to range from 0 to 100 and use two colors, set the ends at value of colors 3-5 to
equal the minimum value, and set color 2 to any value between 0 and 100.

"Ends at"
The "Ends at" field determines the value at which the meter color ends. The range of values is -1,000 to 10,000.
Meter Color 1 is always set to 10,000, since this is the highest value allowed.

Minimum Value
Enter the minimum value for the meter. If a reading is below the minimum value, the meter will point directly
to the left, but still display the correct value.

Maximum Value
Enter the maximum value for the meter. If a reading is above the maximum value, the meter will point directly
up, but still display the correct value.

Press "Next” to continue to the final page of the wizard. Press "Finish " to add this ARC-16 to AutoPilot.

Channel Properties

AutoPilot® 2.0
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Logging In
When AutoPilot starts, you will be prompted to log in.

f” Always log in as this user automatically

Select your user name from the drop down list, and enter your password in the Password field. Click Login to
continue. If you entered your password incorrectly, you will be prompted to log in again. Click Cancel to close
AutoPilot. Note: you can not run AutoPilot without logging in.

Auto Login

Check the "Always log in as this user automatically" box to enable AutoLogin. When AutoPilot starts, it will
automatically log in using the user name and password that you entered. Note: this feature can be turned off
from the Options dialog.

Logging Off

You can log off of AutoPilot by clicking on "Log off..." in the File menu. After logging off, you will prompted
to log in as a different user with the Login dialog.

AutoPilot® 2.0 Support: (978) 486-0086
©2001 Burk Technology, Inc. support@burk.corn



Connecting to your ARC-16
When AutoPilot connects to an ARC-16, it will also talk to all of the other units in the group - allowing you to
control up to four ARCs with one connection. You must add a connection to at least one ARC in the group
before you can connect. You can add connections in the ARC-16 Wizard, or from the Edit menu.

Establish a Connection

Click on the tab for the ARC-16 that you want to connect to, or any other ARC-16 in the same group. To
connect, click "Connect" from the toolbar or File menu. If you have a "default" connection, AutoPilot will use
that connection. Otherwise, you will be prompted to choose from a list of connections for the group. If you want
to override to default, click "Connect Using..." to see the list of connections.

Connection Details

To view the Connection Details dialog, click "Connection Details" from the View menu.

Other ARC-16s using this connection:

WXYZAM

Connected since
The connected since field shows the date and time that the connection was established.

Connected via
Connected via shows the COM Port or modem that AutoPilot is using for the connection.

Quality
The quality field indicates how stable or "clean" the connection is. The field shows a percentage - 100%
indicating a flawless connection. This value is actually the percentage of readable or "good" packets received
from the ARC-16. If some packets are unreadable, you will see a value of less than 100%. If you see a low
value, for example 75%, this means that AutoPilot is unable to read 25% of the data being reported by the ARC.
This also means that if you issue a command, there is a 25% chance that the ARC will not receive it. Poor
connection quality may be the result of a bad null modem cable or a noisy phone line.



Connected to
This shows which ARC-16 you are connected to directly.

Other ARC-16s using this connection
This list includes the other ARC-16s in the group that are connected through the unit in the "connected to" field.

AutoPilot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
support@burk.com

mailto:support@burk.com


Commands
To issue a raise or lower command, just click on the command button, as seen below:

6975 amps

® Off

\ Raise

Y Lower

The command will be issued using the duration that you set in the ARC-16 Wizard. Note: both of the command
buttons for this channel will be "locked out" for the duration of the command. You can still issue commands to
other channels, though.

When a command is issued, it is logged in the Event Log.

If the command is locked out...

A Raise

Lower

Commands will be "locked out" under the following circumstances:

• You are not connected to the ARC.
• You just issued a command to this channel and the duration has not yet elapsed.
• Your ARC-16 is in Maintenance Mode.
• You do not have permission to issue commands.

AutoPilot® 2.0
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Navigation and ARC-16 Status
Navigating between ARC-16s

To switch from one ARC-16 to another, use the tab located below the toolbar.

...... . ,
File Edit View Tools Help

O "WXYZ FM j|  WXYZ AM ]

ARC-16 Status Indicators

Each ARC-16 is shown with a status indicator. This will indicated the connection, alarm, and maintenance
mode status.

 Not connected
 Connected

C5 Connected with an active alarm
 Maintenance mode

C5 Maintenance mode with an active alarm

AutoPilot® 2.0
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Menus, Toolbar, and Status bar
Menus

File

Menu Item Description
New ARC-16 Opens the ARC-16 Wizard to add a new ARC.
Connect Connects using the default connection for the group. If no default is defined, the connection list

will be displayed.
Connect
Using

Displays the connection list.

Print Report Opens the Report Writer.
Export Data Opens the export dialog.
Clear Alarms Clears all alarms on the currently selected ARC-16.
LogOff Logs off the current user and displays the Login dialog.
Exit Closes AutoPilot.

Edit

Menu Item Description
Edit ARC-16 Opens the ARC-16 Wizard to edit the settings for the currently selected ARC.
Connections Opens the Edit Connections dialog.
Groups Opens the Edit Groups dialog.
Delete ARC-16 Deletes the currently selected ARC-16.
Calendars Opens the Calendars dialog.
Users Opens the Edit Users dialog.
Change AutoPilot Password Allows the user who is logged in to change his or her AutoPilotpassword.
ARC-16 Display Order Opens the ARCU6 Display Order dialog.

View

Menu Item Description
Events Displays the Event List.
Alarm History Displays the Alarm History List.
Active Alarms Opens the Active Alarms dialog.
Connection Details Opens the Connection Details dialog.

Tools

Menu Item Description
Enable Logging Enables/disables logging.
Scripts: Enable Scripts Enables/disables scripts.
Scripts: Script Editor Opens the Script Editor.
Scripts: Script Wizard Opens the Script Wizard.
Scripts: Scheduler Displays the Script Scheduler.



[Displays the Options dialog.

Help

Menu Item Description
Contents Opens the help file and displays the Table of Contents.
Index Opens the help file and displays the Index.
Search Opens the help file and displays the Search page.
About AutoPilot Shows the About dialog for AutoPilot.

The Toolbar

Toolbar Item Description
I*?? LogOff Logs off the current user and displays the Login dialog.

Connect Connects using the default connection for the group. If no default is defined, the
connection list will be displayed.

Clear Alarms Clears all alarms on the currently selected ARC-16.
CZ2:
ARC New ARC-16 Opens the ARC-16 Wizard to add a new ARC.

ARC-16
Properties

Opens the ARC-16 Wizard to edit the settings for the currently selected ARC.

& Enable Logging Enables/disables logging.
Report Writer Opens the Report-Writer.

E=l Event List Displays the Event List.
a Alarm History Displays the Alarm History List.

Enable Scripts Enables/disables scripts.
Script Editor Opens the Scri]>t Editor.

l>z Script Wizard Opens the Script Wizard.
Script Scheduler Displays the Script Scheduler.
Edit Calendars Opens the Calendars dialog.
Help Opens the help file and displays the Table of Contents.

The Status Bar

jMaintMode [Administrator ,9:29 AM |09/0S/2001[no Alarms [Ready

Item Description
Alarm LED This LED will be bright red if there is at least one active alarm. The LED will be dim if there

are no alarms.
Alarm
Description

The description will explain what type of alarm most recently occurred, and on what ARC
and channel. "No Alarms" will be displayed if there are no active alarms.

Status This field will display the status of a time consuming operation (such as "Connecting..."). It
will display "Ready" when there is no activity.

Maintenance
Mode

"Maint Mode" will appear if the current ARC is in maintenance mode, otherwise it will
appear dimmed.

Current User Shows which user is presently logged in.



Time Shows the current time.
Date Shows today's date.

AutoPilot® 2.0
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Logging
AutoPilot will log each ARC-16 for which you enabled logging during configuration. AutoPilot will also log
status changes (for channels on which this feature is enabled), alarms, and events.

To enable logging, click "Enable Logging" from the Tools menu in AutoPilot. Notice the logging icon in the
Windows Tray:

V B 11:15AM

S- Logging icon

When logging is disabled, the logging icon will appear with a red line through it. Note: you can enable/disable
logging by right-clicking on this icon in the Tray.

AutoPilot will continue to log after you close the program (the logging icon will remain in the Tray). This
allows you to log without leaving AutoPilot open all the time. If you want to stop logging and close the logging
application, right-click on the logging icon in the Tray, and click on "Exit".

Note: if you are connected to any of your ARC-16s when you close AutoPilot, the logging application
maintains those connections. If you are using a modem and want to free up the phone line, be sure to disconnect
before closing AutoPilot.

Connecting to ARC-16S for Logging

If AutoPilot needs to log an ARC that is not connected, it will connect to the ARC first, and disconnect when it
is finished. Note: you must define a de/aultcpnnection for this feature to work.

If AutoPilot needs to use a modem that is already in use, it will prompt you to either disconnect the modem
first, or cancel the log. If you are not at your computer when this prompt appears, AutoPilot will automatically
disconnect the modem, dial the ARC-16 that it needs to log, and then re-connect the modem.

Using One Modem for Multiple ARC-16s I

Note: AutoPilot can only disconnect/reconnect the modem if it is in use by AutoPilot, not by any other
application (for example, if you are using your modem to connect to the Internet).

AutoPilot can use one modem to log multiple ARC-16s that are not in the same group. To do this, define a
modem connection to at least one ARC-16 in each group that you want to log. When AutoPilot needs to log one
of these ARC-16s, it will use the modem to establish a connection, log each ARC in the group, and then
disconnect - freeing up the modem to log another ARC.

Note: be careful not to configure AutoPilot to log at a very short interval (less than 10 minutes). Because a
modem connection can take a minute or two, AutoPilot will not be able to log all of your sites quickly enough.

Logging Status

To view logging status, double-click on the logging icon in the Tray.



.§> AutoPilot Logging Status^ -|n| x
File Help

09/06/2001 11:03:11 AM
09/06/2001 11:03:08 AM
09/06/2001 11:03:08 AM
09/06/2001 10:51:52 AM
09/06/2001 10:51:49 AM
09/06/2001 10:51:49 AM
09/06/2001 10:51:49 AM
09/06/2001 10:51:48 AM
09/06/2001 10:34:49 AM
09/06/2001 9:55:07 AM
09/06/2001 9:15:28 AM
09/06/2001 9:15:27 AM

Status change logged on WXYZ FM
Status change logged on VZXYZ FM
New alarm logged on 'wXYZ FM
Status change logged on WXrZ FM
Status change logged on WXYZ FM
New alarm logged on ‘wXYZ FM
New alarm logged on WXYZ FM
New alarm logged onWXYZ FM
New alarm logged on WXYZ AM

New alarm logged on WXYZ FM
Status change logged on WXYZ AM
Status change logged on WXYZ AM

Logging disabled

The Logging Status dialog shows if logging is enable/disabled in its status bar, as well as all of the logging
events.

AutoPilot® 2.0
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Alarms
Options for handling alarms can be set using the Options dialog.

Alarm Indicator Icons

;©• Status Alarm
< Low Alarm
< High Alarm

Alarm History

________
ARC-16 Channel Time i
WXyZFM Channel 1 08/31/2001 4:34:41 PM
WXYZFM Channel 3 08/31/2001 4:29:21 PM
WXyZFM Channel 3 08/31/2001 4:29:19 PM

* WXYZFM Channel 3 08/31/2001 4:15:58 PM

The Alarm History list shows all the alarms logged by AutoPilot.

Active Alarms

The Active Alarms dialog shows all the alarms that are currently active. An alarm is active if the channel is still
out of tolerance (above upper limit, below lower limit, or if the status is on).

Check "Hide this list when there are no more alarms" if you want AutoPilot to close this dialog when there are
no longer any active alarms.

Clearing Alarms

To clear alarms on the ARC-16, click "Clear Alarms" from the File menu. Note: this will only clear alarms on
the ARC-16 (the Clear light on the front panel of the unit will turn off). Alarms will still appear as "active" in
AutoPilot until the channel is no longer out of tolerance.

AutoPilot® 2.0
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Events
To view the event list, click "Events..." from the View menu. To change settings for the events list, use the
Options dialog.

Events are categorized using eight Event Types

El Event lisr “ _-JPJx
Time Type Event |
08/31/2001 2:11:16 PM
OS/31/200i' 2:1’6:30 PM
08/31/2001 2:10:28 PM
08/31/2001 2:08:59 PM
08/31/2001 2:08:59 PM
08/31/2001 2:07:29 PM
08/31/2001 2:06:47 PM

Connection___
Application
Application
Connection
Application
Connection
Application

Connected to WXYZ AM_____  ___
Started AutoPilot for Windows version 2.0.224 __
Administrator Logged In
Disconnected from WXrZ AM
Closed AutoPilot for Windows version 2.0.224
Connected to WXYZ AM
Started AutoPilot for Windows version 2.0.224 ▼!

AutoPilot® 2.0
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Event Type Description
Application Application events include logging on/off, and opening/closing the program.
Connection Connection events report connecting, disconnecting, and answering calls.
Commands Command events report Raise and Lower commands.
Alarms Alarm events indicate that Clear Alarms was pressed.
Logging Logging events indicate when logs are taken, and include failed logging connections.

Scripts: Script events include enabling and disabling scripts, as well as error messages produced by
scripts.

Maint Mode Maint Mode events indicate that an ARC-16 went in to, or out of Maint Mode.
Script Message Messages printed from scripts.
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Calendars
Calendars are used in scripts, usually to run operations specific to a certain time of day (such as sunrise or
sunset). You can add as many calendars to AutoPilot as you desire. For each calendar, you can specify a time
zone. All times are entered in Standard Time. AutoPilot will account for Daylight Saving Time when using
calendar values (if the time entered is 5:00 AM for Pre-Sunrise, AutoPilot will interpret Pre-Sunrise as 6:00 AM
during DST).

To add or edit a calendar, click "Calendars..." from the Edit menu.

Adding a new Calendar

Hteir ___ ____ _______________ ______________ __ ____  _ — J—-1—1

Calendars: Name:
----------------------------Tl |New Calendar

Calenda

Enter times in Standard Time:

TimeZone:
jEastern

Month Pre-Sunrise Sunrise Sunset Post Sunset User 1 User 2
January 05:00 AM 06:00 AM
February
March
April
May
June
July
August
September
October
November
December

New | Delete | Save Close I Help |

1. Click the "New" button to create a new calendar.
2. Enter a name for the calendar in the Name field. This name will be used in scripts.
3. If the calendar is not for your local time zone, press the "..." button to open the time zone dialog:
4. Enter times (12 hour) for each field, using Standard Time.
5. Press Save to save your changes.

Modifying a Calendar

To modify a calendar, select the calendar from the Calendars list. You can change the name, time zone, and the
time fields.

To delete the calendar, select it from the list and click the "Delete" button on the dialog.

AutoPilot® 2.0
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Changing your Password
To change your AutoPilot password, click "Change Password" in the Edit menu.

[change Password 

Old Password:

New Password: ——

Confirm New Password: j~

OK Cancel

J
Enter your old password in the "Old Password" field. Enter a new password in the "New Password" and
"Confirm New Password" fields. The password can be up to 16 characters long, and can be left blank if desired.

AutoPilot® 2.0
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ARC-16 Display Order
To change the order in which ARC-16s are displayed in AutoPilot, click "ARC-16 Display Order..." in the Edit
menu.

Select the ARC-16 that you want to move. Click Move Up or Move Down to rearrange the ARCs. Press OK or
Apply to save your changes.

AutoPilot® 2.0
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General
Jjxl

OK

Option! ____<__________________—,__ ______________ _______ _____

General j Alarms | Event List ] Incoming Calls j Auto Login | Purge Data ]

Cancel Apply

I- iShow meter numbers!

Show Meter Numbers

Click Show Meter Numbers to display the number of each meter, as seen below:

171 amps

Time Format

Choose either 12 or 24 hour time. AutoPilot will use this setting when you are prompted to enter times (such as
in the Calendar).

Grid Navigation

The Grid Navigation setting controls the behavior of the TAB key when using a grid in AutoPilot. The first
option, "Tab moves to next control", will use the TAB key to move from the grid to the next field, button, or
other control on the dialog/window. This option facilitates using the keyboard to enter data without needed the
mouse to move to another field. The other option, "Tab moves to the next field in grid", uses the TAB key to
move from field to field within the grid. When the last cell in the grid is reached, the TAB key will not move
the cursor anywhere.

Note: the arrow keys can always be used to move front cell to cell in a grid.

AutoPilot® 2.0 Support: (978) 486-0086



Alarm Options

Show Alarm History
Check this box to show the Alarm History list when a new alarm is found.

Show Active Alarms
Check this box to show the Actjyejklarms list when a new alarm is found.

Play a sound
Check this box to play a sound when a new alarm is found (see below to choose a sound).

Sound File
Click the "..." button to browse for a sound file on your computer. Press play to hear the sound.

Number of alarms to show in Alarm History
Move the slider to set the number of alarms shown in the Alarm History list. The range is 10 to 1000.

AutoPilot® 2.0
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Event Lost
Options Jjxj

General j Alarms i Event List Incoming Calls j Auto Login j Purge Data

Types of events to show in the list:

0 Application
0 Connection
0 Commands
0 Alarms
0i Logging
0 Scripts
0 Maint Mode
0 Script Message

Logging events indicate
when logs are taken, and
include failed logging
connections.

Number of events to show in Event List:

7. ;. ;. ;. . 7.:. :. :. ;. J
10 500 1000

OK Cancel Apply

Types of events to show in the list
Click the check box for each type of event that you want included in the Event List. When you click on a
category, its description will appear to the right of the list.

Number of events to show in the Event List
Move the slider to set the number of events shown in the Events list. The range is 10 to 1000.
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Incoming Calis
Options Jjxj

General j Alarms j Event List i Incoming Calls >| Auto Login ] Purge Data j

Check the modems that you want to answer incoming calls:

2;3Com Windows Modem PCI ADI

OK Cancel Apply

AutoPilot can answer incoming calls from an ARC-16 using your modem(s). To allow a modem to answering
incoming calls, click the check box next to the modem name.

AutoPilot® 2.0
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Auto Logon
Auto Login allows AutoPilot to log in as a specific user when the program stats, without prompting for a
password.

Options

General ] Alarms | Event List ] Incoming Calls [ Auto Login 1] Purge Data i

[7 Enable Auto Login

User:

Password:

Administrator

OK Cancel Apply

Enable Auto Login
Check this box to enable the Auto Login feature.

User
Select the user that you want AutoPilot to use when logging in.

Password
Enter the password for the user you selected.

AutoPilot® 2.0
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Purge Data

Note: the purge settings require administrative privileges.

Purge Settings

Click on the check box for each type of data that you want to purge. Enter the number of days after which
AutoPilot should purge the data. If you enter 30 days for Telemetry, for example, you will never have any
Telemetry records older than 30 days.

AutoPilot will purge old data when it starts up.

Purge Now

Click the Purge Now button to run the purge immediately.

Compacting the Database

Your database files must be compacted periodically to save disk space. AutoPilot will compact at startup, but
this can take several seconds (depending on the size of your database files). Set the number of days after which
AutoPilot should compact.

AutoPilot® 2.0
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Scripts
AutoPilot Scripts allow you to fully automate your sites using the power of Visual BASIC Script.

Scripts will run when Scripting is enabled. To enable scripting, click "Enable Scripts" from the Tools/Scripts
menu. Notice the scripting icon in the Windows Tray:

Y B 11:15 AM |

" Script icon

When scripting is disabled, the script icon will appear with a red line through it. Note: you can enable/disable
scripting by right-clicking on this icon in the Tray.

When you close AutoPilot, scripts will continue to run (the Script icon will remain in the Tray). This allows you
to run scripts without leaving AutoPilot open all the time. If you want to stop scripts and close the scripting
application, right-click on the script icon in the Tray, and click on "Exit".

Note: you can double-click on the script icon to open the Script Scheduler.

Choose from the topics below to learn more:

• Information on AutoPilotJ.x Functions (for users of previous versions of AutoPilot)
• Using the,Script Wizard
• Modifying Wizard-Generated Scripts
• Usiiig_the_Scripf_Editor
• Setting_theScript_Schedule
• Using jheScript. Scheduler
• Script Errors
• Writing Scripts
• Sample Scripts

AutoPilot® 2.0
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AutoPitot 1.x Functions
If you have used a 1.x version of AutoPilot, you are probably familiar with AutoPilot Functions. With AutoPilot
2.0, Functions are no longer used. Instead, AutoPilot uses a scripting language based on Visual BASIC Script
(VBS). To make the transition from Functions to Scripts easier, the following will explain the Script equivalent
to the old Functions.

Function Script Equivalent
If Function Use the GetScripjStatus command in an If ̂ statement.

If Scriptstatus(Script) = x Then

End If
If Date Use the VBS Date() function in an If statement.

If DateO = x Then

End If
If Time Use the VBS Time() function in an l_f statement.

If Time() = x Then

End If
If Day Use the VBS DatePartQ Function in an If statemLent.

If DatePart("w", Now()) = x Then

End If
If Value Use the Value command in an If statement.

If Value(Site, Channel) = x Then

End If
If New Value Use the NewValue command in an If statement.

If NewValue(Site, Channel) = x Then

End If
If Status Use the Status command in an If statement.

If Status(Site, Channel) = x Then

End If
If New Status Use the NewStalus command in an I f statement.

If NewStatus(Site, Channel) = x Then

End If
If Memory Use a variable in an If statement.

Dim MyVar
If MyVar = x Then

End If
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Set Function To run a script, use RunScript.
To stop a script, use StopScript.

Set Memory Use a variable.

Dim MyVar
MyVar = x

Increment Use a variable.

Dim MyVar
MyVar = MyVar + 1

Decrement Use a variable.

Dim MyVar
MyVar = MyVar - 1

Raise Use the Raise command.
Lower Use the Lower command.
Wait Use the Wait command.
Goto Step Use a sub routine.

Call MySub

Sub MySub ()

End Sub
Message Use the Message command.
Print Value Use the Message command.

Message Value(Site, Channel)
Print Status Use the Message command.

Message Status(Site, Channel)
Print Logline Use the TakeLog command.
Connect Use the Connect command.
Disconnect Use the Disconnect command.
Encl Use the EndScripl command.

Note: you do not always need to use EndScript; a script will end after executing its last line of
code.
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Script Wizard
The Script Wizard can help you generate scripts for some common tasks:

• Transmitter Power Trim
• Transmitter Restart
• Transmitter Powerup
• Pattem/Power Change
• Antenna Monitoring
• Tower Light
• Main to Aux
• Site Power Loss Recovery

To launch the wizard, click "Script Wizard..." from the Tools/Scripts menu.

Script Wizard)

Sciipt Wizard
Choose a script template from the list, and give your script a name.

Choose a template:
| T ransmitter Power T rim

Script Name:
|Transmitter Power Trim

Select the template that you want to use, and enter a name for the script. Press Next, and follow the instructions
on each page to tailor the script to your needs. When the wizard is complete, you will have the option to open
the script in the Editor, if you want to make any changes. For help editing the script, see Modifying a Wizard-
Generated .Seri pt.

Note: When you save a script from the Wizard, it will begin to run right away if scripts are enabled. If you want
to edit the script before it runs, save it to another folder on your computer, or disable scripts before saving.
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Modifying Wizard-Generated Scripts
To modify a script that was generated by the Script Wizard, open the script in the Script Editor. The wizard­
generated script looks just like any other script, but includes a list of Constants at the top.

Transmitter Power Trii 

File Edit Help

D eg H [ if* #4 | X d | 
Commend: -

Const WIZ_ARC = "MyARC"
Const UIZ_ANLG_MONPWR = 2
Const WIZJUPLIMIT = 0
Const UIZ_LOLIMIT = 0 i
Const WIZ_CNTRL_RPWR = 1 j
Const WIZ_CNTRL_RPWR_U5ERAISE = False! ;
Const WIZ_CNTRL_LPMR = 2 ! •
Const WIZ_CNTRL_LPUR_USERAISE = True| ' ?

11| 21
[Ready [ins' [CAPS [NUM |SCRL

These constants reflect the settings you entered in the Wizard. You can edit the constant values if you want to
change which ARC-16 or Channel the script uses. You can also add any additional code to the script, or remove
code added by the Wizard.
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Using the Script Editor
To open the script editor, click "Script Editor..." from the Tools/Scripts menu.

Joj2<
File Edit Help

Value "UXYZ FM", 1

Script

D (S S & ® |
Command: Value - ARC-16: WXYZFM » Channel: 1 - y OK

[Ready [ibis’ |cA.PS |NUM |SCRL

Using the Code Builder

The Code Builder Toolbar will help generate script code using AutoPilot Script Commands (so you don't have
to memorize the syntax for every command).

Start by picking the command from the "Command" drop down list. The other fields on the toolbar will change
depending on which command you selected. Fill in the fields, and press the "OK" button on the toolbar to add
the code.

Script Schedule Properties

Click "Properties" from the File menu to change the schedule properties of the script. See Scheduling Scripts for
more information.

Saving your Script

Click "Save" or "Save As..." from the File menu to save your script.

Note: Unless your script is scheduled to Idle, it will begin to run right away (as long as scripts are enabled). If
you do not want the script to run yet, save it to another folder on your computer or disable scripts in AutoPilot.
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Scheduling Scripts
Scripts can be schedule to run in five different ways:

To set the schedule, open the Script Properties dialog from the Script Scheduler or Script Editor. Choose the
type of schedule from the options shown below:

On demand only (Idle)
Continuously
At a certain interval
At a certain time
Betweencertaintimes

Script Propertic 

Name: jscriptl

- Run this script:-----------------------------------------------------------

(* Ion demand on|y( C at a certain time

C continuously C betweencertaintimes

C at a certain interval

On Demand Only (Idle)

The script will only run if run from the Script Scheduler or if RunScript is used to start it from another script.

Continuous

The script will run in a loop. After the script runs, there is a break (about five seconds), and then it will run
again. The script will continue running until the schedule is changed.

Interval

The script will run after a certain interval has elapsed.

~ Interval--------------------------------------------------——■

j 1 C Minutes (* Hours

To set the interval, choose either Minutes or Hours, and enter the interval in the field.

Specific Time

The script will only run at the time selected (accurate to the minute).



i-Schedule

r Daily J“ Sunday

J- Monday

r Tuesday

]“ Wednesday

F“ Thursday

P Friday

|T“ Saturday

The script can be set to run at a specific time, or a calendar time. If using a calendar time, you must select the
calendar that you want to use, as well as the time (Sunrise, Sunset, etc).

The script can run every day, or only on certain days. Check the days of the week on which you want the script
to run.

Between Times

The script will run only if it is between the times selected.

For both the start and stop times, either a specific time or a calendar time can be used. If using a calendar time,
you must select the calendar that you want to use, as well as the time (Sunrise, Sunset, etc).

Note: if you want a script to start running before midnight, and stop running after midnight, AutoPilot will add
one day to the stop time. For example, to run between 10:00 PM and 2:00 AM, just enter those times exactly as
they are. AutoPilot will run the script if it is later than 10:00 PM today or earlier than 2:00 AM tomorrow.

AutoPilot® 2.0 Support: (978) 486-0086



Using the Script Scheduler
To open the Script Scheduler, click "Scheduler..." from the Tools/Scripts menu.

File Scripts Help

AutoPilot Scripts

| .. " US’ | ► □
Script

IB
S Restart Transmitter

Script Status: Idle (Waiting for interval)

Script Status Icons

Status Description
■ Off (Idle) The script is not running.

► Running The script is running.
X> Loop Wait The script is waiting to loop.
ii Paused The script is paused (using Wait).

Waiting to run between certain
times

The script is scheduled to run between two times.

Waiting for Interval The script is scheduled to run after a certain interval.
Scheduled The script is scheduled to run at a certain time.

1101
10... Data Wait The script is waiting for data from an ARC-16 (using NewValue or

NewStatus).
£ Connecting The script is connecting to an ARC-16 (using Connect).

Running and Stopping Scripts

Run
Select the script you want to run and click "Run" from the Scripts menu.

Stop
Select the script you want to stop and click "Stop" from the Scripts menu. Note: this will not change the
schedule of the script, it will just stop the script.

Stop Looping
Select a script that is in Loop Wait and click "Stop Looping" from the Scripts menu. Note: this will not stop the
script, but only prevent it from running again by changing its schedule to Idle. This allows you to stop a loop
while still allowing the script to complete its current run.

Scheduling Scripts

To change the schedule of a script, click "Schedule" from the Scripts menu. See Scheduling Scripts for more 



information.

Editing Scripts

Select the script that you want to edit and click "Edit" from the Scripts menu to open the Script Editor.

To delete the script, click "Delete" from the File menu.

Adding New Scripts

You can add a script using the Editor or the Wizard from the File/New menu.
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Script Errors
If an error occurs in your script, it will be logged in the EventLog. Your script will stop immediately after the
error. Errors may be caused by VBS syntax errors, or by referencing invalid ARCs, channels, connections, etc.

Note: The Event Log will include the line number in your script that caused the error.

Note: a "not found" error may be caused by a spelling mistake.

AutoPilot® 2.0 Support: (978) 486-0086
©2001 Burk Technology, Inc. support^burkxorn

Error Descriptions

Error Cause
Internal Error This is not actually a script error, but an error occurred in AutoPilot while running

your script.
ARC-16 not found Your script referred to an ARC-16 that does not exist in AutoPilot.
Connection not found You used the Connect command and specified a connection that does not exist.
Default connection not
found

You used the Connect command without specifying a connection, but there is no
default connection defined for the group.

Timeout A Connect, NewStatus, or NewValue command failed because it received no response
from the ARC-16.

Invalid channel You specified a channel that is outside of the allowed range (1-16).
Calendar not found A calendar command (Sunrise, Sunset, etc.) referred to a calendar name that does not

exist in AutoPilot.
Script not found A script command (RunScript, SlopScript, etc.) referred to a script that does not exist



Writing Scripts
If you're not familiar with Visual BASIC Script, the tutorials below will get you started. The Scripjt.Cominand
reference is especially useful, even if you already know VBS.

• Microsoft Scripting Reference
• IfStatements
• yariabJes.airdjConstaiils
• Siib Routines
• Loops
• Date/Time Functions
• AutoPilot Script Commands
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If Statements
Use the VBS If statement in a script to make a decision. The If statement follows this basic structure:

If [condition] Then
[action]
End If

If...Then

Here is an example of a simple If statement that prints a message if an analog channel is over 1000.

Example

If Value("MyARC", 1) > 1000 Then
Message "Channel 1 is above 1000”

End If

Using Else

You can add an Else clause to give the If statement an alternative. This example prints ON if the status is on,
but prints OFF otherwise.

Example

If Status("MyARC", 1) = True Then
Message "Channel 1 is ON"

Else
Message "Channel 1 is Off"

End If

Using Elself

Use Elself to write more complex statements. If the first condition fails, the second condition will be tested.
You can still use Else to provide an alternative if your If and Elself conditions fail. Note: you can use as many
Elself statements as you like.

This example tests an analog channel for a reading over 1000. If the reading is less than 1000, it tests for a
reading of less than 0. If both of these conditions are false, the Else action will be used.

Example

If Value("MyARC", 1)
Message "Channel

Elself Value("MyARC"
Message "Channel

Else
Message "Channel

End If

> 1000 Then
1 is above 1000"
1) < 0 Then
1 is below 0"

1 is between 0 and 1000"

AutoPllot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
support@burk.com

mailto:support@burk.com


Variables and Constants
You can use a variable to store data temporarily in a script. A variable can be changed while the script is
running. A constant is like a variable, only it must be assigned a value when it is declared. Constants can not be
changed, however.

Declaring a variable

To declare a variable, use the Dim keyword, followed by the variable name. Note: variable names can be up to
255 characters long, and must be unique (you can not use the same variable name twice in one script).

To assign a value to a variable, just use the variable name followed by "=". Note: if the variable is going to hold
text, you must use "quotes".

Example

'Create a variable named MyVar, and set it to equal 0
Dim MyVar
MyVar = 0

'Add 1 to the variable
MyVar = MyVar + 1

'Assign the text "hello" to the variable
MyVar = "hello"

Declaring a Constant

To declare a constant, use the Const keyword followed by the constant name, and assign it a value in the same
step. Note: Constant names follow the same rules as variable names (see above).

Example

'Create a constant named MyConst and set it to 100
Const MyConst = 100

Note: it is a good idea to use constants in your scripts when dealing with unchanging values, such as ARC-16
names.

Example

'Use a constant to represent an ARC-16 named "WXZY FM Backup"
Const MyARC = "WXYZ FM Backup"

'Raise channel 1 on this ARC
Raise MyARC, 1
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Functions and Subs
Functions and Subs are used to encapsulate code in your script that you can run from elsewhere inside the
script. This is useful if you want to perform the same action in different places in your script.

Subs

To declare a sub, use the Sub keyword followed by a unique name for the sub. Yom- sub must end with "End
Sub." Here is the format of a sub:

Sub SubName(Parameter!, Parameter!, ...)
[action]
End Sub

You can use as many parameters as you want, or none at all. To run a sub, use Call followed by the name of the
sub.

Example

Sub MySub(MyParameter)
Message MyParameter

End Sub

'This will write a message with the text "hello"
Call MySub("hello")

Functions

A function is just like a sub, only it "returns" a result. To assign the return value, include a statement like this:

FunctionName = Value

Example

Function MyFunction(MyParameter)
MyFunction = MyParameter + 1

End Function

'This will write a message with the text "2"
Message MyFunction(1)
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Loops
You can use loops to repeat a section of code. See Microsoft Scripting Technologies for a complete reference
on loops. This section will cover "Do Loops". The basic structure of a Do Loop is:

Do
[action]
Loop

You must be sure to give your loop a way to stop. Otherwise, it will run forever! Three ways of doing this are
illustrated below:

Do While ... Loop

This kind of loop will run while a condition is true. Note: if the condition is false when the loop starts, your
action(s) will not run.

Example

'Raise a channel while its value is less than 1000
Do While NewValue("MyARC", 1) < 1000

Raise "MyARC", 1
Loop

Do... Loop Until

This loop will run until a condition is true. Unlike the previous example, however, it will always run at least
once.

Example

'Raise a channel until its status is On.
Do

Raise "MyARC", 1
Loop Until NewStatus("MyARC", 1) = True

Exit Do

You can also stop a loop by including an "Exit Do" statement inside of the loop.

Example

'Raise a channel, but stop the loop if the ARC-16 is disconnected
Do

Raise "MyARC", 1

If IsConnected("MyARC") = False Then
Exit Do

End If
Loop
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Date/Time Functions
VBS includes many functions dealing with date and time. For a complete reference, see Microsoft Scripting
Technologies. Here are just some of these functions:

Using Literal Date/Time

To use a date or time "literally" in a script, you must begin and end the value with the pound sign (#). For
example:

#1/1/2002#
#January 1, 2002#
#1:00 PM#
#13:00#
#1/1/2002 1:00 PM#

Now

Description

Returns the current date and time.

Example

'Print a message with the current date/time
Message Now()

Date

Description

Returns the current date.

Example

■Print a message with current date
Message Date()

Time

Description

Returns the current time.

Example

■See if it is after 5:00
If Time() > #5:00 PM# Then

End If

AutoPilot® 2.0
©2001 Burk Technology. Inc.

Support: (978) 486-0086
support@burk.com

mailto:support@burk.com


AutoPilot Script Commands

Command
ARCTime
Conned
Disconnect
IsConnected
IssueCommand
Raise
Lower
Status
Value
NewS.tatus
NewVaJuc

ARC-16 Commands
Description
Converts current time to the time zone used by the ARC-16.
Connects to an ARC-16, and (optionally) the other ARCs in the group.
Disconnects from an ARC-16 and all other ARCs in the group.
Determines if the ARC-16 is already connected.
Sends a Raise or Lower cdm nand.
Sends a Raise command. 1
Sends a Lower command/
Gets the Status of a Channel?
Gets the Analog Value of a Channel.
Gets the Status of a Channel after waiting for a new reading.
Gets the Analog Value of a channel after waiting for a new reading.

Command
Calendar Dates

Description
PreSunrise
Sunrise
Sunset
PostSunset
Userl
User2

Gets the Pre-Sunrise time from a Calendar.
Gets the Sunrise time from a Calendar.
Gets the Sunset time from a Calendar.
Gets the Post Sunset time from a Calendar.
Gets the User 1 time from a Calendar.
Gets the User 2 time from a Calendar.

Command
GetSjcriplSjajus
RunScript
StopScripl
UnScheduleScript

Script Commands
Description
Gets the status of a script.
Runs a script.
Stops a script.
Sets a script to "Idle."

Command
Wait
Message
TakeLog
EndScript

Other Commands
Description
Pauses for a number of milliseconds.
Writes a message to the Event Log.
Takes a log.
Stops the script.
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ARCTime
Description

Use the ARCTime command to convert the current time to the time zone used by the ARC-16. If your ARC is
in your local time zone, you will not need this command.

For example: if you are in EST, and your ARC-16 is in CST, at 5:00 Eastern ARCTime will return 4:00.

Syntax

ARCTime^ R CNam e)

Parameters

Return

Parameter Description
ARCName Name of the ARC-16 (use "quotes")

ARCTime returns a time value.

Example

'See if it is past Sunrise in the ARC'S time zone:
If ARCTime(11 MyARC") > Sunrise("MyCalendar") Then

End If
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Connect
Description

Connects to an ARC-16, and optionally to all the other ARCs in that group.

Syntax

Connect(ARCName, Connection, ConnectAll)

Return

Parameters

Parameter Description
ARCName Name of the ARC-16 to which you want to connect (use quotes).
Connection (Optional) Name of the connection that you want to use (use quotes). Leave blank to use the

default connection.
ConnectAll (Optional) Use True to connect to all the other ARCs in the group; otherwise use False. If left

blank, True is assumed.

The Connect command will return a message indicating the status of the connection:

• "Connected"
• "Bad Password"
• "Incorrect Serial Number"
• "Busy Signal"
• "Connection Canceled"
• "Device Not Found"
• "Communication Error"
• "No Answer"
. "No Dialtone"
• "No Response From ARC-16"

Example

'Connect to MyARC using MyConnection, and connect all the other ARCs in the group:
Connect "MyARC", "MyConnection", True
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Disconnect
Description

Disconnects from the ARC-16 specified, as well as all other ARCs in the group.

Syntax

Disconnect(/17?CTVmne)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).

Example

'Disconnect from MyARC
Disconnect "MyARC"
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IsConnected
Description

Use IsConnected to determine if AutoPilot is already connected to your ARC-16.

Syntax

IsConnected(/17? CName)

Parameters

Return

Parameter Description
ARCName Name of the ARC-16 (use quotes).

IsConnected will return True or False.

Example

'If not already connected, run the Connect command
If Not IsConnected("MyARC") Then

Connect("MyARC")
End If
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IssueCommand
Description

Sends a Raise or Lower command to the ARC-16.

Syntax

IssueCommand(^7?C7Vame, Channel, UseRaise, Duration)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number
UseRaise True for Raise, False for Lower.
Duration (Optional) Duration of the command in seconds (can use decimal). If left blank, 1 second is

used.

Example

’Send a Raise command to MyARC channel 12 for 3 seconds
IssueCommand "MyARC”, 12, True, 3
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Raise
Description

Issues the Raise command to the ARC.

Syntax

Raise(ARCName, Channel, Duration)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number
Duration (Optional) Duration of the command in seconds (can use decimal). If left blank, 1 second is

used.

Example

'Raise Channel 1 on MyARC for 2.5 seconds
Raise "MyARC", 1, 2.5
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Lower
Description

Issues the Lower command to the ARC.

Syntax

Lo\ver( ARCName, Channel, Duration)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number
Duration (Optional) Duration of the command in seconds (can use decimal). If left blank, 1 second is

used.

Example

'Lower Channel 1 on MyARC for 2.5 seconds
Lower "MyARC", 1, 2.5
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Status
Description

Reads the status of a channel on the ARC-16.

Syntax

Stat\is(ARCName, Channel)

Parameters

Return

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number

The Status command will return True if the channel is on, or False if it is off.

Example

■Issue a lower command if Channel 8 on MyARC is on.
If Status("MyARC", 8) = True Then

Lower("MyARC", 8)
End If
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Value
Description

Returns the analog value of the channel specified.

Syntax

'Value(ARCName, Channel)

Parameters

Return

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number

The Value command will return a number, which can contain a decimal point.

Example

'Issue a raise command to Channel 1 on MyARC if the value is greater than 10.5
If Value("MyARC", 1) >10.5 Then

Raise("MyARC", 1)
End If
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NewStatus
Description

NewStatus is just like Status, only it waits for a new reading from the ARC-16 rather than using the last reading
received. It may take several seconds for NewStatus to return a value.

Note: NewStatus is best used when you are waiting for the result of another action. For example, if you issue a
Raise command to turn a channel on, use NewStatus to see if the command was successful.

Syntax

NewStatus(/t7?CM/we, Channel)

Return

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number

The NewStatus command will wait for a reading from the ARC-16, and then return True if the channel is on, or
False if it is off.

Example

'Issue a raise command to turn on Channel 4 on MyARC.
'Then issue a raise command to channel 5 if it was successful:
Raise("MyARC", 4)
If NewStatus("MyARC", 4) = True Then

Raise("MyARC", 5)
End If
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NewValiae
Description

NewValue is just like Value, only it waits for a new reading from the ARC-16 rather than using the last reading
received. It may take several seconds for NewValue to return the channel's analog value.

Note: NewValue is best used when you are waiting for the result of another action. For example, if you issue a
Raise command to increase the value of a channel, use NewValue to see if the command was successful.

Syntax

NewValue(,47?C7Vame, Channel)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).
Channel Channel Number

Return

The NewValue command will return a number, which can contain a decimal point.

Example

'Use a Loop to raise a Channel 1 on MyARC until it is greater than 1000.
Do Until NewValue("MyARC", 1) > 1000

Raise("MyARC", 1)
Loop
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PreSunrise
Description

PreSunrise returns the "Pre-Sunrise" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

PreSunrise(CaZenctar)

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

'See if it is after PreSunrise using MyCalendar
If Now() > PreSunrise("MyCalendar") Then

End If
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Sunrise
Description

Sunrise returns the "Sunrise" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

Simrise(Calendar')

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

'See if it is after Sunrise using MyCalendar
If Now() > Sunrise("MyCalendar") Then

End If
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Sunset
Description

Sunset returns the "Sunset" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

SmsetlCalendar)

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

■See if it is after Sunset using MyCalendar
If Now() > Sunset("MyCalendar") Then

End If
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PostSunset
Description

PostSunset returns the "Post Sunset" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

PostSunset(CaZewcfar)

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

'See if it is after PostSunset using MyCalendar
If Now() > PostSunset("MyCalendar") Then

End If
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Userl
Description

Userl returns the "User 1" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

Userl (Calendar)

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

'See if it is after User 1 time using MyCalendar
If Now() > Userl("MyCalendar") Then

End If
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User2
Description

Userl returns the "User 2" value of a calendar.

Note: All calendar functions will convert the time to your local time zone, and automatically adjust for Daylight
Saving Time. This is done so that you can compare times without having to worry about time zones.

Syntax

TJser2(Calendar)

Parameters

Return

Parameter Description
Calendar Name of the calendar (use quotes).

Returns a time value, which is converted to your local time zone.

Example

'See if it is after User 2 time using MyCalendar
If Now() > User2("MyCalendar") Then

End If
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GetScriptStatus
Description

Returns the status of a script.

Syntax

GetScriptStatusGS'crzpt)

Parameters

Return

Parameter Description
Script Name of the Script (use quotes).

GetScriptStatus will return one of the following statuses:

. "Off
• "Running"
• "Scheduled"
• "Looping"
. "Paused"
. "DataWait"
• "Connecting"

Example

■If the script MyScript is off, run it"
If GetScriptStatus("MyScript") = "Off" Then

RunScript "MyScript"
End If
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RunScript
Description

Runs a script.

Syntax

RunScript(Scrzpt)

Parameters

Parameter Description
Script Name of the Script (use quotes).

Example

’Run MyScript
RunScript "MyScript”
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StopScript
Description

Immediately stops a running script. Note: if the script is looping, you must use UnScheduIeScript to prevent it
from running again.

Syntax

StopScript(5crzpt)

Parameters

Example

•Stop MyScript
StopScript "MyScript"

Parameter Description
Script Name of the Script (use quotes).
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UnScheduleScript
Description

Changes the script's schedule to "Idle." Use this on a script that is looping to prevent it from running again.
Note: UnScheduleScript will not actually stop a script, use StopScript to stop the script immediately.

Syntax

UnScheduleS cri p [(Script)

Parameters

Parameter Description
Script Name of the Script (use quotes).

Example

'UnSchedule MyScript
UnScheduleScript "MyScript"
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Wait
Description

Pauses the script for the specified number of milliseconds.

Syntax

Wait(_Dwra/zcw)

Parameters

Example

Parameter Description
Duration Number of milliseconds to wait.

'Issue two commands, spaced 2 seconds apart
Raise "MyARC", 1
Wait 2000
Raise "MyARC", 2
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TakeLog
Description

Takes a log on the specified ARC-16.

Syntax

TakeLog(/l 7? CMzme)

Parameters

Parameter Description
ARCName Name of the ARC-16 (use quotes).

Example

'Take a log on MyARC
TakeLog "MyARC"
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EndScript
Description

EndScript can be used to immediately stop the script.

Note: you do not always need to use EndScript; scripts will stop when the last line of code is executed. You
only need to use EndScript to stop before the last line of code.

Syntax

EndScript

Example

•End the script if MyARC is not connected:
If Not IsConnected("MyARC") Then

EndScript
End If
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Using the Report Writer
To open the Report Writer, click "Print Report..." from the File menu in AutoPilot. For more information on a
specific topic, choose from the list below:

• General (date range, paper orientation, and time zones)
• Telemetry
• Status Channels
• Other Fields (status changes, alarms, and events)
• Report Header
• RcportJFooter
• Saying yourreport femplate
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Report Writer: General Tab
| J3 AutoPilot Reports

File Help

H | BuB | k? ~
General ] Telemetry | Status Channels ] Other Fields ] Header j Footer ]

- Date range----------------------------------------------------------------------------------

f7 From: 108/06/2001 jJ P jfol j09/06/2001 _J

Sort by date: C Ascending (• Descending

- Paper orientation--------------------------------------------------------------------------

(• Portrait C Landscape

Maximum analog channels that will fit on the page: 13

- Time Zones---------------------------------------------------------------------------------

(• Leave times in remote time zones

(• Sort chronologically

C Sort literally

C Convert times to local lime zone

Date Range
Click the From and/or To check box to limit the report to a date range. Use the calendar drop down to pick
dates. You can sort your report in either ascending or descending order.

Paper Orientation
The report is designed for 8.5" x 11" paper. You can printer in either portrait or landscape. This determines how
many analog channels you can include in the report.

Time Zones
If you are including data from other time zones in your report, you need to consider how to handle the time
values. If all of your data is from the same time zone, just leave this set to "Leave times in remote time zones."

There are three ways to sort time zones:

Sort Method Description
Leave in remote lime zones;
Sori chronologically

Time values will be left in their original time zones. Records will be sorted
chronologically. This means that some values may appear to be out of order. If
you have one ARC in Eastern Time, another in Pacific Time, and are sorting in
ascending order: 2:01 PST will appear after 5:00 EST

Leave in remote time zones;
Sort literally

Time values will be left in their original time zones. Records will be sorted
literally. This means that some of your records will be out of order, but the time
values will appear in numerical order. For example, if sorting in ascending



order: 3:00 EST will appear after 2:00 PST, even though 3:00 EST is earlier
than 2:00 PST.

Convert times to local time
zone

All time values will be converted to whatever your local time zone is. If you're
in Easter Time, AutoPilot will add three hours to values from a Pacific Time
site.

Note: The time calculation takes into account Daylight Saving Time. This means
that records logged before DST will be printed as if they had been logged during
DST (values from the fall will be increased by one hour). If your report will
include both Standard and DST times, you may want to use one of the other
sorting options. \ |

Telemetry
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Report Writer: Teiemetry Tab
t -- .. xi

File Help

h I a s I _______________
General Telemetry j status Channels j Other Fields ] Header | Footer j

Choose the site and channel for each column:

Number of readings columns to use: fj 71

Col. ARC-16 Analog Channel |
1 WXYZFM Channel 1
2 ▼

If you want to include analog readings in your report, first select the number of channels that you want to
include. The number of channels available is determined by the paper orientation (see General tab).

For each column, choose the ARC-16 and analog channel. You are not limited to one ARC per report - you may
include channels from as many ARC-16s as you like.

Note: You can not use the same channel from the same ARC twice.

Status Channels
4s General
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Report Writer: Status Channels Tab

About Status Logs...

AutoPilot records status channels in two ways. When an ARC-16 is logged, AutoPilot records the values of all
the status channels. Also, when the status of a channel changes, AutoPilot records the change in the Status
Changes log.

This section of the Report Writer allows you to include logged status - status changes are part of the Other
Fields tab.

Adding Status Channels

If you want to include Logged Status, choose the ARC-16 from the drop down list, select the desired channel
from the "Select a status channel" list, and click Add. You may add as many status channels from as many
ARCs as you like. Note: use the Add All button to add all the status channels from the selected ARC-16.

Removing Status Channels

To remove a status channel from the report, select it in the bottom list and click Remove. Use Remove All to
remove all status channels from the report.

Other Fields
Telemetry



Report Writer: Other Fields Tab
krmpitfithiiVMF"__ ;____Z.7

File Help

ei I Bi I *? t
General | Telemetry | Status Channels Other Fields j Header | Footer ]

- Select sites to include for Status Changes and Alarms-------------------------

Status Changes: Alarms:
iSjWrZFM [gwXVZFM

 WtZAM  VvXYZAM

- Types of events to include in the report---------------------------------------------

 Application
 Connection
 Commands
 Alarms
 Logging
 Scripts
 Maint Mode

§ Script Message

Messages printed from scripts.

Status Changes

Note: The Status Changes log indicates a change in status. To include status channels that are logged along with
analog values, see the Status Channels tab.

To add status changes to your report, click on the check box next to the desired ARC-16(s) in the Status
Changes list.

Alarms

If you want to include alarms in your report, click the check box next to the desired ARC-16(s) in the Alarms
list.

Events

To include events in your report, click the check box next to each of the type of events that you want to include.
Note: when you click on an event type, a description of that type will appear in the area to the right of the list.

Header
Status Channels

AutoPilot® 2.0 Support: (978) 486-0086
©2001 Burk Technology, Inc. support@byfk.com

mailto:support@byfk.com


Report Writer: Header Tab

Report Header

The report header will appear at the top of the report, before the page header.

Report Title
Enter a title for your report. The title will appear in large letters at the top of the header.

Print Date Range
Check this box to print the range of dates included in the report. Note: the date range is determined by the
records that are actually included in the report, not just by the date range you entered in the General tab.

Print Time Zone Information
Check this box to print a description of how time zones are handled in the report (as you specified in the
General tab).

Additional Text
Add any additional text that you want to include in the report header. You can add as many lines of text as you
like.

Page Header

The page header will appear at the top of each page in the report.



Site Name
Check this box to print the name of the ARC-16 for each analog value included in the report.

Channel Name
Check this box to print the channel name for each analog value.

Analog Value Units
Check this box to print the units label for each analog value.

Additional Text
Add any additional text that you want to include in the page header. You can add as many lines of text as you
like.

Footer
Other Fields

AutoPilot® 2.0
©2001 Burk Technology, Inc.

Support: (978) 486-0086
support@burkxom



Report Writer: Footer Tab

File Help

H | & S [ *? t
General | Telemetry | Status Channels | Other Fields | Header Footer j

Report Footer

The report footer will appear on the last page of the report, above the page footer.

Additional Text
Add any additional text that you want to include in the report footer. You can add as many lines of text as you
like.

Page Footer

The page footer will appear at the bottom of every page in the report.

Print Today's Date
Check this box to print today's date in the footer.

Page Number
Check this box to print the page number in the footer.

Additional Text
Add any additional text that you want to include in the page footer. You can add as many lines of text as you
like.



Saving and Printing Reports
Saving Reports

If you are going to reuse this report in the future, you can save the template. To do this, click "Save..." on the
Report Writer's File menu. You will be prompted to choose a file name.

Note: you are saving the template (the layout of the report), but not the actual data included in the report. This
allows you to print a similar report in the future, but always with current data.

Opening Saved Reports

To load a previously saved template, click "Open..." from the File menu in the Report Writer. You will be
prompted to pick a template file. Select the file you want to use and click Open. All of the settings that you
saved with this template will be loaded into the Report Writer.

Printing

To preview your report, click "Print Preview..." from the File menu. You will see a progress dialog while your
report is generated. Note: it may take up to several minutes to generate a lengthy report, depending on the speed
of your computer. You can then print from the preview window.

If you do not need to preview the report, click "Print..." from the File menu. You will see the progress dialog
and then be prompted to choose a printer.
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Exporting Data
You can export your alarm history, event log, status changes, and telemetry to a comma separated value (CSV)
file. CSV files can be opened in many applications, including Microsoft Excel and Access.

To export, click "Export Data..." from the File menu in AutoPilot.

Select the data to export:

Progress:

Close i 'Export

Select the table that you want to export from the drop down list, and click Export. You will prompted for a file
name. Note: the export may take several minutes, depending on the speed of your computer and how much data
you have logged.
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Contact Burk Technology
Burk Technology
7 Beaver Brook Rd
Littleton, MA 01460

For technical support:
Email: suppprt@buri<xpm
Phone: (978) 486-0086

For sales:
Email: sales@burk.com
Phone: 1-800-255-8090

Visit Burk Technology on the web at wxyw.burk.com.
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Glossary
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T erm Description
Alarm There are three kinds of alarms: high, low, and status. A high or low alarm occurs when an

analog channel is above or below the limits set on the ARC-16 (Limits Monitoring must be
turned on). A status alarm occurs when the status of a channel is ON, and the status alarm is
enabled for that channel.

Authorization
Code

An Authorization Code is required to use an ARC-16 with AutoPilot. Codes are issued by
Burk Technology, and are specific to your Serial Number and Program Key. Contact Burk if
you need an Authorization Code.

Calendar An AutoPilot Calendar consists of 6 user-defined times for each month. The times are Pre­
Sunrise, Sunrise, Sunset, Post Sunset, User 1, and User 2. Times are always in Standard Time.

Connection A connection is the link between your computer and the ARC-16. A connection can use either
a COM Port or a Modem. When you connect to an ARC, AutoPilot can communicate with all
of the units that are linked to that ARC (the other units in the group).

Default
Connection

If a connection is defined as the default for the group, AutoPilot will use that connection
without first prompting you to choose from a list of connections. If you only have one
connection in a group, it is a good idea to set it as the default.

Demo Mode You can run AutoPilot in Demo Mode by leaving the Program Key field blank when you
install AutoPilot. Demo Mode will allow you to run AutoPilot for 15 days, unrestricted. After
the 15-day demo, you must purchase AutoPilot to continue using it (AutoPilot will not run
without a Program Key after the Demo period).

Group A group can comprise between one and four ARC-16s, each connected to each other. When
ARCs are grouped, AutoPilot can communicate with the whole group when the computer is
connected to just one of the ARCs.

Idle Script A script is idle when it is not running and not waiting for anything (such as a scheduled run
time or interval, etc).

Maintenance
Mode

The ARC-16 can be put into Maintenance Mode (Maint Mode) by pressing the Maint button
on the front panel. When in Maint Mode, you will not be able to issue commands (raise and
lower) to the ARC from the computer.

Program Key The Program Key is issued by Burk Technology when you purchase AutoPilot for Windows.
You will need a program key to install the software and add ARC-16s. If you do not have a
program key, you can install AutoPilot in Demo Mode. To obtain a Program Key, contact
Burk.

Script An AutoPilot Script lets you automate AutoPilot and your ARC-16(s). AutoPilot Script is
based on Visual BASIC Script (VBS), and includes a library of commands specific to
AutoPilot.

Site Letter Every ARC-16 is assigned a site letter (A, B, C, or D) when it is first configured. This
identifies the ARC uniquely when it is connected to other units in a group.

User User accounts in AutoPilot allow you to grant only certain privileges to individuals.
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